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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer
“Documentation” means information published by Avaya in varying
mediums which may include product information, operating
instructions and performance specifications that Avaya may generally
make available to users of its products and Hosted Services.
Documentation does not include marketing materials. Avaya shall not
be responsible for any modifications, additions, or deletions to the
original published version of documentation unless such
modifications, additions, or deletions were performed by Avaya. End
User agrees to indemnify and hold harmless Avaya, Avaya's agents,
servants and employees against all claims, lawsuits, demands and
judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation, to the
extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: http://support.avaya.com or such successor site as
designated by Avaya. Please note that if You acquired the product(s)
from an authorized Avaya Channel Partner outside of the United
States and Canada, the warranty is provided to You by said Avaya
Channel Partner and not by Avaya.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, ARE
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR
INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC.,
ANY AVAYA AFFILIATE, OR AN AVAYA CHANNEL PARTNER (AS
APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH
AVAYA OR AN AVAYA CHANNEL PARTNER. UNLESS
OTHERWISE AGREED TO BY AVAYA IN WRITING, AVAYA DOES
NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS
OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The

applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
computing device. “Server” means a Designated Processor that
hosts a software application to be accessed by multiple users.
“Instance” means a single copy of the Software executing at a
particular time: (i) on one physical machine; or (ii) on one deployed
software virtual machine (“VM”) or similar deployment.

License types
Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only on a number of
Designated Processors up to the number indicated in the order.
Avaya may require the Designated Processor(s) to be identified in
the order by type, serial number, feature key, Instance, location or
other specific designation, or to be provided by End User to Avaya
through electronic means established by Avaya specifically for this
purpose.

Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software currently
available for license from Avaya is the software contained within the
list of Heritage Nortel Products located at http://support.avaya.com/
LicenseInfo under the link “Heritage Nortel Products” or such
successor site as designated by Avaya. For Heritage Nortel
Software, Avaya grants You a license to use Heritage Nortel
Software provided hereunder solely to the extent of the authorized
activation or authorized usage level, solely for the purpose specified
in the Documentation, and solely as embedded in, for execution on,
or for communication with Avaya equipment. Charges for Heritage
Nortel Software may be based on extent of activation or use
authorized as specified in an order or invoice.

Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization
Each product has its own ordering code and license types. Note that
each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.

Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: http://
support.avaya.com/Copyright or such successor site as designated
by Avaya. You agree to the Third Party Terms for any such Third
Party Components.
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Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: http://support.avaya.com or such
successor site as designated by Avaya. Suspected security
vulnerabilities with Avaya products should be reported to Avaya by
sending mail to: securityalerts@avaya.com.

Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: http://support.avaya.com, or such successor site as
designated by Avaya.

Contact Avaya Support
See the Avaya Support website: http://support.avaya.com for product
or Hosted Service notices and articles, or to report a problem with
your Avaya product or Hosted Service. For a list of support telephone
numbers and contact addresses, go to the Avaya Support website: 
http://support.avaya.com (or such successor site as designated by
Avaya), scroll to the bottom of the page, and select Contact Avaya
Support.

Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, or other third parties. Users are not permitted to use such
Marks without prior written consent from Avaya or such third party
which may own the Mark. Nothing contained in this site, the
Documentation, Hosted Service(s) and product(s) should be
construed as granting, by implication, estoppel, or otherwise, any
license or right in and to the Marks without the express written
permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Purpose
The Avaya Identity Engines Ignition Server Getting Started guide explains how to install and
configure the Avaya Identity Engines Ignition Server. This guide is written for network administrators
who want to quickly install and configure the Ignition Server.

The Avaya Identity Engines Ignition Server Getting Started guide explains a simple configuration,
and the Avaya Identity Engines Ignition Server Administration guide provides a complete reference
showing other configuration options.

Related resources

Documentation
See the following related documents.

Title Purpose Document number
Avaya Identity Engines Ignition
Server Administration

All configuration options NN47280–600

Configuring and Managing Identity
Engines Single-Sign-On

Configuration, management, and
deployment

NN47280–502

Avaya Identity Engines Ignition
Guest Manager Configuration

Installation, configuration, and
management

NN47280–501

Avaya Identity Engines Ignition
CASE Administration

Installation, configuration, and
deployment

NN47280–603

Avaya Identity Engines Ignition
Access Portal Administration

Installation, configuration, and
deployment

NN47280–604

Avaya Identity Engines Ignition
Analytics

Installation, configuration, and
maintenance

NN47280–601

Avaya Identity Engines Ignition
Server Release Notes

Reference NN47280–400
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Training
Ongoing product training is available. For more information or to register, you can access the Web
site at http://avaya-learning.com/.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot Avaya
products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos posted
on the website.

Note:

Videos are not available for all products.

Subscribing to e-notifications
Subscribe to e-notifications to receive an email notification when documents are added to or
changed on the Avaya Support website.

About this task
You can subscribe to different types of general notifications, for example, Product Correction
Notices (PCN), which apply to any product or a specific product. You can also subscribe to specific
types of documentation for a specific product, for example, Application & Technical Notes for
Ethernet Routing Switch 8800.

Related resources
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Procedure
1. In an Internet browser, go to https://support.avaya.com.

2. Type your username and password, and then click Login.

3. Under My Information, select SSO login Profile.

4. Click E-NOTIFICATIONS.

5. In the GENERAL NOTIFICATIONS area, select the required documentation types, and then
click UPDATE.

6. Click OK.

7. In the PRODUCT NOTIFICATIONS area, click Add More Products.

8. Scroll through the list, and then select the product name.

9. Select a release version.

10. Select the check box next to the required documentation types.

Introduction
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11. Click Submit.

Searching a documentation collection
On the Avaya Support website, you can download the documentation library for a specific product
and software release to perform searches across an entire document collection. For example, you
can perform a single, simultaneous search across the collection to quickly find all occurrences of a
particular feature. Use this procedure to perform an index search of your documentation collection.

Before you begin
• Download the documentation collection zip file to your local computer.
• You must have Adobe Acrobat or Adobe Reader installed on your computer.

Procedure
1. Extract the document collection zip file into a folder.

2. Navigate to the folder that contains the extracted files and open the file named
<product_name_release>.pdx.

3. In the Search dialog box, select the option In the index named
<product_name_release>.pdx.

4. Enter a search word or phrase.

5. Select any of the following to narrow your search:

• Whole Words Only

• Case-Sensitive

• Include Bookmarks

Searching a documentation collection
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• Include Comments

6. Click Search.

The search results show the number of documents and instances found. You can sort the
search results by Relevance Ranking, Date Modified, Filename, or Location. The default is
Relevance Ranking.

Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Introduction
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Chapter 2: New in this release

The following sections details what is new in Avaya Identity Engines Ignition Server Getting Started
for Release 9.2.

Features
See the following section for information about feature changes.

Guest Manager Enhancements
Following are the Guest Manager enhancement features for release 9.2.

Guest Manager Localization
In this release Guest Manager supports Localization for Provisioner and Self-Provisioning
templates.

Sponsor Approval Workflow
Sponsor Approval Workflow allows Guest Users to select sponsor details from pre-populated list in
Guest User Self-Provisioning Portal. Admin can configure the Active Directory Group from which the
sponsors list is populated.

Avaya idEngines IDR Android App
Ignition Guest Manager introduces an Android Smartphone Application which simplifies the device
registration for the provisioner.

Additional Guest Manager Enhancements
Guest Manager usability enhancements include the following:

• Allow admin to set schedule for automated configuration export.
• Added drop-down list for Device Types and Sub Types in Device Self-Provisioning Portal and

Create or Edit Device page in Provisioner Application. The Device Types and Sub Types are
populated from Ignition Server.

• Added a link in Provisioning Groups > Actions and click View Provisioning Group to view
provisioning group summary.

For more information about the above features, see Configuring Avaya Identity Engines Ignition
Guest Manager, NN47280-501.
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Guest Manager REST API
Guest Manager REST API allows third party developers (Customers and Business Partners) who
want to integrate Guest Manager with other standalone or web applications to GET Guest Users
and Devices from Ignition Guest Manager.

For more information, see Avaya Identity Engines Ignition Guest Manager REST APIs,
NN47280-505.

Avaya Unified Access Enhancements
Following are the Unified Access enhancement features for release 9.2.

Fabric Attach Client Devices
The Ignition Server allows you to differentiate Fabric Attach Client devices from other devices. The
Fabric Attach Client devices node is added to list all the FA devices under Internal Store > FA
Client Devices.

Change of Authorization
Ignition Server Release 9.2 introduces Change of Authorization (CoA) for Avaya ERS switches and
WLAN 9100 APs. IDE supports Dynamic Authorization Extensions to Remote Authentication Dial In
User Service (RADIUS).

With this feature support, an administrator will be able to send the Disconnect messages that
terminate a particular session. Administrator can also change the attributes of an authenticated User
or Device dynamically by triggering Change of Authorization (CoA) Messages from Ignition
Dashboard.

For more information about the above features, see Avaya Identity Engines for Avaya Unified
Access, NN47280-503.

Ignition Server Administration Enhancements
Following are the Ignition Server Administration enhancement features for release 9.2.

Access Policy Templates
Ignition Server Release 9.2 introduces Access Policy Templates. Dashboard is the comprehensive
GUI for configuring IDE. Policy configuration is the most important configuration in Dashboard. It
affects the authentication and authorizations of users and devices. Certain policies like RADIUS
authentication for Avaya switches require standard configuration. It will help customers if these
configurations are provided as templates. These templates can be copied directly into policies by
administrators.

Usability Enhancements
Usability Enhancements includes the following:

• In Nodes > Status tab, Copy button is added to copy the Serial Number.
• In Access Policy > Authorization Policy tab, line break for outbound values and vertical

scroll bar is added to the Rules Summary.

New in this release
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• All the files that user desire to save are saved in My Document by default.
• In Directories > Internal Stores > Device Types, admin can define Device Types and Sub

Types for a Device.
• In Configuration > Provisioning > Vendor VSAs, option is added to view the vendor Id.
• The option to remove the older version of Dashboard while installing the new version is

removed. The older version should be removed manually if required.
• Dashboard version and build number is displayed on the windows bar to differentiate the

versions of Dashboard.
• In Directory Services the supported directory servers are grouped in to different service types.

AirWatch Mobile Device Management
IDE 9.2 release extends the support for mobile device management (MDM) by integrating AirWatch
MDM services. This new MDM feature provides more control and secure access to BYOD
deployment in a corporate network.

For more information about the above features, see Administering Avaya Identity Engines Ignition
Server, NN47280-600.

Features
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Chapter 3: Getting started

Use this chapter to perform these Avaya Identity Engines Ignition Server installation and
configuration tasks. Perform your set-up in the following phases:

1. Installing the Ignition Server virtualization appliance on page 15

2. Preventing automatic VMware tools updates on page 20

3. Configuring the Ignition Server virtualization appliance on page 22

4. Installing the Ignition Dashboard desktop application on page 23

5. Running the Dashboard on page 29

6. Obtaining the Ignition Server Serial Number on page 30

7. Obtaining PLDS licenses on page 32 or Obtaining KRS licenses on page 33

8. Installing the license on page 33

9. Setting up the Service Port (Optional) on page 37 and Setting the admin password and
user, site, and node names on page 38

10. Further configuration on page 39

VMware ESXi server
Hardware platforms supported by VMware's ESXi Servers versions 5.1 and up are supported. The
VM requires an x86_64 capable environment, a minimum of 4 GB of memory, a minimum of 250 GB
of available disk storage (thin provisioning is allowed), a minimum of four CPUs, at least one
physical NIC card (preferably three NICs), and three Logical NIC cards. VMware lists on its site
supported hardware platforms for ESXi.(http://www.vmware.com)

Installation on a VMware ESXi server is done using an OVA file, which already incorporates the OS
Red Hat Enterprise Linux.

Reminder: Avaya provides the Identity Engines Ignition Server, Ignition Guest Manager, and
Ignition Access Portal as Virtual Appliances. Do not install or uninstall any software components
unless Avaya specifically provides the software and/or instructs you to do so. Also, do not modify
the configuration or the properties of any software components of the VMs (including VMware Tools)
unless Avaya documentation and/or personnel specifically instructs you to do so. Avaya does not
support any deviation from these guidelines.
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Warning:

Do not install or configure VMware Tools or any other software on the VM shipped by Avaya:

• Avaya does not support manual or automated VMware Tools installation and configuration
on Avaya supplied VMs.

• Turn off automatic VMware Tools updates if you have enabled them. Refer to the
instructions in Preventing automatic VMware tools updates on page 20 to disable
automatic updates and to check if you have accidentally installed VMware tools.

• Avaya determines which VMware Tools to install and configure. When required, Avaya
provides these tools as part of the installation or package upgrade procedures. Avaya
provides these tools because VMware Tools configures the kernel and network settings
and unless Avaya tests and approves these tools, Avaya cannot guarantee the VM will
work after the tool is installed and configured.

• Avaya does not support the installation of any VMware specific, RHEL specific, or any third
party vendor package or RPM on its VM other than what Avaya ships as a package,
image, or OVF.

Installing the Ignition Server virtualization appliance
Use the VMware vSphere Client to import the VM into your system. Start the VMware vSphere
Client and log in to the ESXi Server on which you want to install the Avaya Ignition Server. You
need to use the Virtual Appliance Deploy OVF Template option.

Procedure
1. From the VSphere Client, select File > Deploy OVF Template.

2. The Source screen displays. Select the location from which you want to import the Ignition
Server virtual appliance.

Installing the Ignition Server virtualization appliance
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3. Click Next.

In the OVF Template Details screen, review your settings. You can click Back to make
changes, or click Next to continue.

4. The End User License Agreement screen displays. Click Accept to accept the license and
click Next.

Getting started
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5. The Name and Location screen displays. You can either accept the default name or choose
to rename the virtual machine. Click Next.

6. The Datastore screen displays. Select the location where you want to store the files for the
virtual appliance and click Next.

Installing the Ignition Server virtualization appliance
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7. The Disk Format screen displays. Select a format in which to store the virtual machine’s
virtual disks and click Next.

Getting started
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8. The Network Mapping screen displays. Associate the Avaya Ignition Server NICs to the
correct VM Network based on your site configuration. Then click on Next.

9. The Ready to Complete screen displays. Review your settings. Use the Back button to
make any changes or click Finish to start the import.

The Import now starts. Once the import completes you should see a Summary window
display.

10. After the import completes, you must verify and adjust some of the VM settings. Open the
VM setting dialog and select the Options tab. Do the following:

a. Click the Synchronize guest time with host option.

b. Change the System Default Power Off from Power off to Shutdown Guest. Click OK.

c. Open the VM setting dialog and select the Hardware tab. Adjust the Network Adapter
(1/2/3) settings and configure the right NIC for each interface. You are now ready to
boot the Avaya Ignition Server for the first time. A splash screen displays as the boot up
starts.

d. Avaya does not support manual or automated VMware Tools installation and
configuration on Avaya supplied VMs. Refer to Preventing automatic VMware tools
updates on page 20 for information on how to prevent automatic updates for VMWare
Tools.

Installing the Ignition Server virtualization appliance

August 2015 Avaya Identity Engines Ignition Server Getting Started Configuration     19
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Identity Engines Ignition Server Getting Started Configuration


11. Once the Ignition Server Console login prompt displays, you are ready to enter the
administration IP address. Login using admin for the user name and admin for the password.
You should change the password after you login.

Preventing automatic VMware tools updates
Use this procedure to prevent automatic VMware Tools updates.

Procedure
1. Use the Vmware vSphere Client to log in to the ESXi Server hosting the Ignition VM.

2. Select the VM corresponding to the Ignition Server.

3. Go to Getting Started > Edit Virtual Machine Settings > Options > VMware Tools >
Advanced, and ensure the Check and upgrade Tools during power cycling check box is
not selected. This is the supported setting.

4. Click OK.
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Checking the VMware Tools status (ESXi 5.1 and up)
The Summary tab of the VM describes the VMware Tools status.

To check the VMware Tools status on an ESXi (5.1 and up) server:

Procedure
1. Use the vSphere client to log in to the ESXi Server.

2. Go to the Summary tab.

After a fresh install, the VMware Tools status displays as “VMware Tools: Running
(Current)”.

Checking the VMware Tools status (ESXi 5.1 and up)

August 2015 Avaya Identity Engines Ignition Server Getting Started Configuration     21
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Identity Engines Ignition Server Getting Started Configuration


Note:

VMware Tools may show as not installed. This is a known VMware issue where VMware
Tools may not be detected correctly on certain hardware. However, this does not
interfere with the functioning of the tools—it is a display issue only.

Configuring the Ignition Server virtualization appliance
About this task
Use this procedure to configure the Ignition Server virtualization appliance.

Procedure
1. Boot the Avaya Ignition Server for the first time.

2. Once the Ignition Server Console login prompt displays, you are ready to enter the
administration IP address. Login using admin for the user name and admin for the password.
You should change the password after you login.

3. Use the interface commands as shown in the next screen to configure the admin interface.

• Only Static IP configuration is supported.

• Configure your admin interface with an IP address.
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CLI command example: “interface admin ipaddr x.y.z.x/netmask”

• If needed, configure your default route.

CLI command example: “route add 0.0.0.0/0 <gw-ip> “

Installing the Ignition Dashboard desktop application
The Avaya Ignition Dashboard is a desktop application that enables you to manage the Ignition
Server appliance. The Avaya Ignition Dashboard enables you to create, view, or alter configuration
information for authenticators, service categories, and the policies that apply to authentication and
authorization.

Before you begin
To proceed with the Ignition Dashboard installation, have the following tools and information ready:

• The Identity Engines product software shipped with your Ignition Server appliance.
• A computer running Windows 7 (32 bit or 64 bit), Windows 8 (32 bit or 64 bit), or Windows

Server 2008 (32 bit or 64 bit).
• A minimum of 2 GB of RAM memory.
• The default System administrator name (admin) and password (admin).

Procedure
1. If any version of the Avaya Ignition Dashboard exists on the computer, ensure the Ignition

Dashboard application is not currently running. If the Ignition Dashboard is running, shut it
down now.

2. Place the Ignition Server CD into the CD drive of your computer. On Windows, the Windows
AutoRun feature runs the Installer immediately.

Note: If the AutoRun feature is disabled on your computer, navigate to your CD drive and
double-click the installer file. It has a name like DashboardInstaller-9.1.0<Build
Number>.exe.

Installing the Ignition Dashboard desktop application
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Note:

Older version of Ignition Dashboard will not be deleted installing the new version.

3. In the License Agreement screen, scroll down to read the entire license. Select the radio
button to accept the license and click Next.
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4. In the Choose Install Folder screen, choose your destination folder and click Next.

5. In the Choose Shortcut Folder screen, indicate where you want the Dashboard shortcut to
appear, and click Next.

Installing the Ignition Dashboard desktop application
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6. In the Pre-Installation Summary screen, review your installation settings. If you want to
make changes, click Previous to edit the details of the locations of the installation. When
you finish your configuration, click Install. The installer displays a pre-install confirmation
window.

7. In the Pre-Installation Summary confirmation window, click OK to confirm the installation.
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Important:

Ignition Dashboard requires JRE 1.8.0_45 to operate correctly. For this reason, during
the Dashboard installation, JRE 1.8.0_45 is installed in static mode. For information on
JRE static installation, see the “Static Configuration” section of the JRE installation at 
http://docs.oracle.com/javase/7/docs/webnotes/install/windows/jre-installer-options.html.

You can upgrade the system JRE that is installed on your machine by default, but do not
delete the JRE 1.8.0_45 version from your machine either manually or as part of the
JRE upgrade. If you delete JRE 1.8.0_45, the Ignition Dashboard application will not
function as expected and results in unpredictable behavior.

The installation starts. The installer displays a dialog box that displays the progress of the
installation.

Installing the Ignition Dashboard desktop application
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8. If the appropriate Java Runtime Environment (JRE) is already installed, a window appears to
allow you to skip re-installing JRE. Click OK to skip the re-installation of JRE.

The installation continues. The installer displays a dialog box showing the progress of the
installation.
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9. When the installation is complete, the installer displays the Install Complete screen. In the
Install Complete screen, click Done. An icon for Ignition Dashboard appears in the location
you designated.

Installing multiple versions of the Ignition Dashboard: You can install multiple versions
of Ignition Dashboard on a single workstation. When you run the installer, it installs the new
version in its own folder. The new installation does not interfere with existing Ignition
Dashboard installations and creates a new icon to launch the new version of Ignition
Dashboard. The installer leaves the existing Ignition Dashboard installation and icon intact.

Running the Dashboard
If your Ignition Server appliance is connected only via its Admin Port, skip this section and go to 
Further configuration on page 39. If your installation will use Service Port A, follow these steps:

Procedure
1. On your administration computer, start Ignition Dashboard by doubleclicking its icon on the

desktop.

2. In the login screen, type the default User Name: admin. Type the default Password:
admin.

3. In the Connect To: field, type the fully-qualified domain name or the IP address you
assigned to the Ignition Server appliance Admin Port.

Running the Dashboard
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4. A dialog box appears saying Base License Required. You can install the license later as
described in Installing the license on page 33. Be sure to first read Obtaining the Ignition
Server Serial Number on page 30. For now, dismiss the popup by clicking OK.

5. A warning dialog appears reminding you to replace the default certificate shipped with the
Ignition Server appliance. Ignore the warning. (For instructions on replacing the certificate,
see the Avaya Identity Engines Ignition Server Administration Guide.)

After you dismiss the warning dialog, the Ignition Dashboard appears.

Next steps
If you already have your Ignition Server license, go to Installing the license on page 33.

Obtaining the Ignition Server Serial Number
The Avaya Identity Engines Ignition Server software ships without any licenses. There are seven
different software licenses that can be installed on Ignition Server: Base License, Guest Manager
License, NAP Posture License, TACACS+ License, Ignition Reports License, Access Portal
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License, and Avaya Aura® Single-Sign-On (SSO) License. At a minimum, you must obtain the Base
License to be able to configure and run the server.

If you are applying a NAP Posture License or an Access Portal License, select the Access Portal
License that matches the Ignition Server Base License (LITE, SMALL, or LARGE).

Note:

Beginning with Identity Engines Release 9.0, Identity Engines starts to transition from DVD
delivery to electronic software delivery. Depending on how you place your order, you may
receive DVDs with paper LACs, or electronic software delivery and electronic LACs. With each
method you will receive instructions on how to obtain your licenses.

Once you have purchased Identity Engines, depending on how you placed your order you
receive either a set of DVDs accompanied with paper LACs (License Authorization Codes), or
else you receive electronic delivery of your LAC by email and you then download the software
from Avaya support site via PLDS.

Avaya provides a telephone number for you to use to report problems or to ask questions about
your product. The support telephone number is 1-800-242-2121 in the United States. For additional
support telephone numbers, see the Avaya Web site: http://www.avaya.com/.

Once you have installed both the Ignition Server Virtual Appliance and the Ignition Dashboard, you
must obtain the Ignition Server node Serial Number (also known as the Host-ID) from the
Dashboard. The Ignition Server Serial Number is required in order to generate licenses regardless
of whether they are KRS licenses or PLDS licenses. Beginning with Release 9.0, the Ignition Server
Serial Number is always a string of 12 digits.

If you have a paired server High Availability (HA) deployment, you need to obtain the Serial
Numbers of both Ignition Servers that make up the HA-pair.

Procedure
Do one of the following:

a. In the VMWare vSphere Client, launch the Ignition Server CLI and enter the command show
version.

b. From the Dashboard Configuration tree, click the name or IP address of your node, click the
Status tab.

Click Copy to save the Serial Number to the clipboard.

Obtaining the Ignition Server Serial Number
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Obtaining PLDS licenses
If you have received your LAC by electronic delivery (email), your licenses are PLDS licenses.

Using the Avaya Product Licensing and Delivery System (PLDS), you can activate the license
entitlements and download the products.

Upon your purchase of Identity Engines, you receive an electronic LAC with which you, as a
customer or Avaya Business Partner who has permissions in PLDS for your site or sales order, can
access PLDS and generate license entitlements for you. You must provide the Serial Number, also
known as the host ID, of the Identity Engines Ignition Server and your LAC in order to generate a
license. The LAC helps you to identity the product among other Avaya products you hold licenses
for and to keep track of the number downloads, while keeping the required groups and coordinators
informed through e-mail messages. The LAC e-mail recipients must be identified during the order
placement process by providing their e-mail addresses.

With the LACs in hand, you can use the Quick Activation screen to activate the LACs and download
the product.
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Obtaining KRS licenses
If you received paper LACs with your purchase, follow the instructions on the paper LACs regarding
how to obtain your licenses. These will be KRS licenses.

Send an email to datalicensing@avaya.com to request your KRS licenses and include the following
information:

1. End user company name and full mailing address (no mailboxes).

2. End user company URL.

3. End user contact name.

4. End user corporate email address.

5. End user phone number.

6. License Authorization Code (LAC) that shows in the box at the bottom right of the LAC
certificate.

7. Serial Number or Serial Numbers if you have an HA deployment.

After the information is verified, licenses are sent to you by email.

Installing the license
Avaya Identity Engines currently supports the KeyCode Retrieval System (KRS) and Avaya Product
Licensing and Delivery System (PLDS) licensing models. The Avaya PLDS model provides
customers, Business Partners, distributors and Avaya Associates with easy-to-use tools for
managing asset entitlements and electronic delivery of software related licenses. Using PLDS, you
can perform activities such as license activation, license de-activation, license re-host, and software
downloads.

There are a few key differences between the two types of licenses which are important to
understand especially if you will be using both types of licenses.

Important:

Note the following:

• Ignition Server supports both KRS and PLDS licenses to accommodate customers who do
not yet have access to Avaya PLDS. Over time, Identity Engines will transition to support a
single licensing system—PLDS.

• An important difference between KRS licenses and PLDS licenses is that KRS licenses are
individual licenses while a PLDS license file always includes all PLDS licenses within a
single PLDS license file, which is in XML format.

• A PLDS license file ALWAYS has at a minimum a Base license.

• KRS licenses can be exported from the Dashboard and saved on your desktop.

Obtaining KRS licenses
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• PLDS licenses cannot be exported from the Dashboard. Therefore, it is very important to
ALWAYS safeguard the PLDS license file you have received from PLDS. You may be able
to log back in to PLDS and regenerate the license file again.

• Installing PLDS licenses deletes any PLDS and KRS licenses that are already installed .
Therefore, it is important to export all KRS licenses before installing PLDS licenses in order
to safeguard your KRS licenses.

• Since KRS licenses are deleted when installing PLDS license, before installing PLDS
license you MUST export and save the KRS licenses if any already exists.

• Installing KRS licenses overwrites any installed PLDS licenses.

You install the license on the Ignition Server using Dashboard. The procedure for installing PLDS
and KRS license is the same.

Procedure
1. In the Dashboard’s Configuration tree, click the name of your site and click the Licenses tab.

2. Click Install.

3. Browse to the license file location, select, and click OK.

The following example shows a PLDS license installation.
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The following example shows an installed PDFS license.

Installing the license
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The following example shows an installed KRS license.
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Setting up the Service Port (Optional)
Follow this procedure to configure the Service Port.

Procedure
1. In Dashboard’s Configuration tree, click the name or IP address of your node.

Setting up the Service Port (Optional)
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2. Click the Ports tab, and click the Service Port entry.

3. Click Edit .

4. In the Edit Port Configuration window, do the following:

• Select the Enable Port checkbox.

• Enter the port address in the IP Address field, and enter the subnet mask in the field to
the right. You must enter the subnet using network prefix notation (an integer between 0
and 32 representing the number of bits in the address that will be used in the comparison).

Setting the admin password and user, site, and node
names

Follow this procedure to configure the administration password, user, site, and node names.
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Procedure
1. In Dashboard’s Configuration tree, click the name of your site.

2. From the Actions menu (at the upper right), select

• Change User Name to change the administrator login name

• Change Password to change the administrator password

• Rename Site to rename the site. A site is typically a pair of Ignition Servers, but it may
consist of just one server.

3. To rename your node (your Ignition Server appliance), in Dashboard’s main navigation tree,
right-click on the IP address or name of your node and select Rename Node.

Next steps
Your basic set-up is complete. See Further configuration on page 39 for your next steps.

Further configuration
To prepare the Ignition Server appliance for testing or production use, your next step is to connect it
to your switches, wireless access points, and user data stores, as explained in the next chapter, 
Configuration on page 40. For more detailed information about Ignition Server features, see
Administering Avaya Identity Engines Ignition Server, NN47280–600.

Further configuration
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Chapter 4: Configuration

The chapter assumes you are familiar with network terminology, have experience setting up and
maintaining networks and network security, and have installed your Ignition Server appliance as
shown in the previous chapter, Getting started on page 14.

The following steps describe how to configure Ignition Server for providing Network Access Control:

• Creating a RADIUS access policy on page 45

• Creating a user in the internal user store on page 47

• Setting up your connection to a user store on page 48

- Connecting to Active Directory on page 49

- Connecting to LDAP on page 64

• Setting up a RADIUS proxy server on page 73

• Creating a directory set on page 79

• Creating virtual groups on page 81

• Creating authenticators on page 85

• Setting your authentication policy on page 88

• Setting your identity routing policy on page 90

• Setting your authorization policy on page 93

• Testing your configuration on page 99

Make sure you have a copy of Administering Avaya Identity Engines Ignition Server, NN47280–600
available. Avaya Identity Engines Ignition Server Getting Started Configuration explains a simple
configuration, whereas Administering Avaya Identity Engines Ignition Server provides a complete
reference showing other configuration options.

See Configuring And Managing Avaya Identity Engines Single-Sign-On (NN47280–502) for help
configuring Ignition Server to provide Single-Sign-On for applications.
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Before you begin
Make sure you have completed the following set-up tasks before you start configuring the Ignition
Server appliance.

1. Network settings: Complete the steps shown in the previous chapter, Getting started on
page 14

• Set up the Ignition Server appliance and set its network settings.

• Install Ignition Dashboard on your Windows OS.

2. Switch settings: Configure each authenticator (network switch or wireless access point) to
recognize the Ignition Server appliance as its RADIUS server. To do this, use the
management tools of each switch to set the switch’s RADIUS server address to the Ignition
Server ADMIN or SVC interface IP address. (By default, Ignition Server handles RADIUS
requests on its ADMIN interface, but you can change this to the SVC interface as shown in 
Step 5 on page 43.) Use UDP port 1812 as the RADIUS server port.

3. 802.1X settings: If you will use 802.1X authentication:

• Use the management tools of each switch or access point to enable 802.1X authentication
on that device.

• On client machines that will connect to the network, make sure a wireless/wired, 802.1X-
capable supplicant is installed and configured for 802.1X authentication.

• If you wish to follow the example configuration in this document, make sure the supplicant
is set up for PEAP/MSCHAPv2 authentication.

4. RADIUS accounting settings: If you will use RADIUS accounting, configure your switch or
access point to send its accounting packets to the Ignition Server appliance. To do this, use
the management tools of your device, setting the appropriate Ignition Server IP address as
the RADIUS server address and port 1813 as the RADIUS accounting port.

5. VPN client settings: If you will use IPSec for VPN access, make sure that client machines
(those that will VPN into the network) have an installed VPN client that speaks PAP or
MSCHAPv2.

Next Steps: Proceed to the next section to set up the Ignition Server appliance.

Configuring the Ignition Server appliance
You use Ignition Dashboard to set the Ignition Server appliance, perform network configurations,
and specify the network parameters for the RADIUS Service.

Procedure
1. Start Ignition Dashboard: Double-click Ignition Dashboard icon on your Start > Programs >

Ignition Dashboard > Ignition Dashboard. The application displays its login window.
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2. Type the System administrator User Name and Password. The default login credentials are
admin/admin. In the Connect To field, enter the IP address of your Ignition Server
appliance, and click OK.

Initially, the Default Certificate window appears alerting you that you are using the default
Ignition Dashboard-to-Ignition Server certificate (“admin certificate”) that was shipped with
Ignition Dashboard. Click OK to dismiss the window. (Avaya recommends that you later
consult the “Certificates” chapter of the Avaya Identity Engines Ignition Server Administration
Guide and replace the certificate as explained there.)

Dashboard displays its main window, which consists of three tabs, a navigation tree, and a
reading and editing panel.

3. In the Configuration tree, click on Site 0, then right-click on Site 0 and select the Rename
Site command. In the Rename Site dialog, type a name for your site. Your site is your

Configuration
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Ignition Server or your HA pair of Ignition Servers. In this example, we use the name
Sunnyvale Campus. Click OK to accept the new name.

4. In the navigation tree, click on the machine name or IP address of the Ignition Server
appliance you wish to configure. The application displays the Nodes panel, which allows you
to manage network settings on the appliance, and check its current status.

Hint: The Actions menu allows you to manage the appliance hardware (actions such as
rebooting and shutting down). To use the Actions menu, right-click the IP address of your
Ignition Server in the navigation tree, or, with the IP address selected, click the Actions menu
at the upper right.

5. Optional: If you intend to separate your authentication network from your network
management network, do the following. For most installations, this is not necessary.

a. Do this only if your authentication network is separate from your management network.
Activate the Service Port (“SVC”): In Dashboard’s navigation tree, click the IP
address/name of your node. Click the Ports tab, click the Service Port row, and click
Edit. Click the Enable check box and, in the IP Address field assign an address to the
port. In the adjacent field type the net mask. Click OK.

b. Do this only if your authentication network is separate from your management network.
Bind Ignition Server’s RADIUS service to the service port (“SVC”): In Dashboard’s
navigation tree, click the name of your site (for example, Site 0 or Sunnyvale Campus).
Click the Services tab, click the RADIUS tab, and click Edit.

Configuring the Ignition Server appliance
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In the Edit RADIUS Configuration window, set the Bound Interface to Service Port. In
the Authentication Port and Accounting Port fields, use the default values of 1812 and
1813 unless your authenticators require a different RADIUS server port. Click OK.

c. Do this only if you authentication network is separate from your management network:
Make sure you have plugged in the cable connecting the Ignition Server’s SVC interface
to the network that contains your switches, access points, and other authenticators.

6. Reboot your Ignition Server by right-clicking its IP address in the navigation tree and
selecting the Reboot command.

Configuration
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Next steps
Proceed to the next section to create a basic access policy.

Creating a RADIUS access policy
Your RADIUS access policy contains the rules that determine how a user must authenticate and,
based on the user’s identity, what network the user will be allowed to use.

Each authenticator has one RADIUS access policy applied to it, meaning that all users connecting
through that authenticator are governed by that RADIUS access policy.

Procedure
1. If Dashboard is not connected to your Ignition Server, select Administration > Login, and

provide the necessary credentials.

2. In the Dashboard’s Configuration tree, click Site Configuration, and click Access Policy in
the main window.

3. In the New Access Policy window, type a name for your policy and click the RADIUS check
box. The name typically offers a clue as to which authenticators will use this policy. For
example, the name may indicate the location of the authenticators.

Creating a RADIUS access policy
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4. Click OK.

Your access policy has been saved. For now, leave the policy empty. (Later, you can add
rules to it in the Dashboard Configuration tree by expanding Site Configuration > Access
Policies > RADIUS , selecting your policy and using the tabs and Edit buttons in the main
panel to edit the policy.)

You will add rules to your access policy later, as shown in the section Setting your
authentication policy on page 88.

Next steps
Create a user account as shown in Creating a user in the internal user store on page 47.

Configuration
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Creating a user in the internal user store
This section is optional. If you do not plan to use the Ignition Server internal user store, skip this
section and go to Setting up your connection to a user store on page 48.

Ignition Server typically authenticates users against your corporate user store (for example an
Active Directory or LDAP store), but the Ignition Server appliance also contains a local store, called
the internal user store. You can use the embedded store to complement your corporate AD or LDAP
store. For example, you may wish to create temporary guest user accounts in the embedded store,
rather than placing them in the corporate user store where employee accounts reside.

This section creates a user account in the internal user store. Later, we will build the access policy
to determine this user’s access rights.

Procedure
1. In the Dashboard’s Configuration tree, expand Site Configuration > Directories > Internal

Store and click Internal Users. At the bottom of the window, click New.

Creating a user in the internal user store
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2. In the User Name field, enter sclemens, in First Name enter Samuel, in Last Name enter
Clemens, in Password enter secret12 (or any password you like), in Confirm Password
enter the password again. Click OK to save the user.

Next steps
Connect to your enterprise user store as shown in Setting up your connection to a user store on
page 48.

Setting up your connection to a user store
The Avaya Identity Engines’ Ignition Server appliance can be configured to retrieve users from any
combination of internal and external data stores, including external Active Directory (AD) and LDAP
stores, as well as the internal user store of the Ignition Server appliance.

The set of connection settings for a data store is called a directory service in Ignition Server. This
section shows you how to create a directory service. For each store you wish to use, you will define
one directory service. After you define your directory services, you will place them in directory sets
that tell Ignition Server when to use which service.
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Note:

If you are using only the Ignition Server embedded store to store user accounts, you do not
need to create a directory service. Instead, proceed to Creating a directory set on page 79.

To connect to your used data store, use one of the following procedures:

• Preparing to connect to Active Directory on page 51

• Connecting to LDAP on page 64

Connecting to Active Directory
The rest of this section explains how to connect to an Active Directory data store that contains your
site’s user accounts and groups. Once the Ignition Server has connected to AD and joined the
domain, it can authenticate users against Active Directory.

Gather Active Directory connection settings
Use the AD connection settings that you used and created, or talk to your AD administrator to find
the connection settings for your AD data store. Record them in the table that follows. Gather this
information for each store that will authenticate users.

Setting name Setting value
AD Domain Name The Active Directory domain that holds your user accounts. Domain

names typically carry a domain suffix like “.COM” as in, for example,
“COMPANY.COM”.

Service Account Name The name of the AD administrator account that the Ignition Server
will use to connect to the AD server. In the documentation, we refer
to this account as the Ignition Server service account. If you wish to
perform MSCHAPv2 authentication, the service account must have
permission to create and delete computer accounts (the Create
Computer Object and Delete Computer Object permissions) in the
Netlogon account root in Active Directory. See “Netlogon account
root DN,” below. If you have not specified a Netlogon account root
DN in Ignition Server, then the service account must have these
permissions in the Computers container of your AD service.

Ignition Server uses the service account to join the Active Directory
domain. Joining the domain requires creating a machine account in
the Netlogon account root and periodically resetting the password on
that account for security. The machine account itself is necessary to
perform Netlogon authentication requests for MSCHAPv2 traffic to
Active Directory.

Note:

Make sure that the name you enter here is the
sAMAccountName of the administrator. The sAMAccountName
is usually the user id of the user without the domain prefix. For

Table continues…
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Setting name Setting value

example, the sAMAccountName for the user COMPANY.COM/
Administrator will usually be Administrator.

For help creating the service account, see Creating the Service
Account in AD on page 53. For help setting its permissions, see 
Setting the AD permissions of the service account on page 55.

Service Account Password The password for the AD service account. Do not record the
password here.

Security Protocol Specifies whether Ignition Server should SSL-encrypt traffic to the
directory service. Avaya Identity Engines recommends that you use
an SSL connection.

IP Address (Primary) The IP Address of the primary AD data store.
Port (Primary) The LDAP Port of the primary AD data store. For SSL enter 636. If

SSL is not used, enter 389. You cannot use the global catalog port
(3268). Use the LDAP ports (389 and 636) only!

Name The Name you will use in Ignition Server to identify this AD data
store. This can be any name.

NetBIOS Domain The NetBIOS Domain name (pre-Windows 2000 domain name) of
your AD data store. This setting is typically written in all uppercase
letters, as in, “COMPANY”. This setting applies only to Active
Directory stores. For instructions on using Microsoft tools to find this
name, see Looking up AD settings to find Domain and NetBIOS
names on page 71.

NETBIOS Server Name Optional. Allows Ignition Server to find the NETBIOS server where
Ignition Server will perform the Netlogon (a prerequisite to performing
MSCHAPv2 authentication). If the NETBIOS Server Name is not
specified, then Ignition Server relies on DNS to find the NETBIOS
server. Avaya strongly recommends that you specify a NETBIOS
Server Name to ensure that MSCHAPv2 authentication can continue
when the DNS server is unavailable. The directory service set-up
wizard will help you determine the NETBIOS server name by
retrieving a list of domain controllers in the domain.

Directory Root DN The root of the AD tree containing your groups and schema,
expressed using X.500 naming. For example, dc=company,dc=com.
When you connect the directory service, the Ignition Server Create
Service wizard will attempt to choose a Directory Root DN for you.
See Looking up AD settings to find Root DNs on page 70 for
information on finding this DN.

User Root DN The User Root DN specified the AD container that holds your user
records, expressed using X.500 naming. For example,
cn=users,dc=company,dc=com or
ou=uswest,ou=americas,dc=company,dc=com. When you connect
the directory service, the Ignition Server Create Service wizard will
attempt to choose a User Root DN for you. See Looking up AD

Table continues…
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Setting name Setting value
settings to find Root DNs on page 70 for information on finding this
DN.

Netlogon Account Root DN The container in AD where the Ignition Server will create its own
machine account when joining the AD domain. This setting is
optional. If specified, Ignition Server will only attempt to create its
machine account in the specified location. If left unspecified, Ignition
Server obtains the Netlogon account root DN from the domain
controller. Specifically, Ignition Server gets the DN of the well known
computer root from the DC and uses that as the Netlogon account
root DN.The Netlogon account root DN is typically the Active
Directory Computers container (by default, this has a DN similar to
cn=computers,dc=company,dc=com). The machine account is
required so that Ignition Server can perform Netlogon authentication
requests for MSCHAPv2 traffic to AD. If you wish to perform
MSCHAPv2 authentication, then your service account must have
appropriate permissions in this DN. For help setting account
permissions, see Setting the AD permissions of the service
account on page 55.

Preparing to connect to Active Directory
Check and, if needed, address the following before you try to connect.

Warning:

If you plan to use MSCHAPv2 authentication, you must perform the checks listed here.

Procedure
1. Make sure you have gathered your AD connection settings as explained in Gather

Active Directory connection settings on page 49.

2. Check your clock settings. When the Ignition Server connects to an Active Directory
server, the Ignition Server clock must be in sync with the clock on the Active Directory
Server. If the clocks are out of sync, then the Ignition Server cannot connect to the Active
Directory store.

3. Check your firewall settings. If a firewall protects your Active Directory server, make sure it
does not block the ports required by Ignition Server. Ignition Server needs access to the
following ports: 88 (UDP), 389 (TCP), 445 (TCP), 464 (UDP), 636 (TCP).

4. Check your Active Directory security settings. Ignition Server works with all default
installations of AD, but if you have adjusted your AD installation to prohibit NTLMv1
authentication, then Ignition Server cannot perform MSCHAPv2 authentication.

To make sure NTMLv1 authentication is enabled in your AD installation, check the following
two settings in the Windows registry of your Windows domain controller (DC). Use the
Windows regedit tool to do this.

• Make sure that the following key is not set on the DC:

HKLM\System\CurrentControlSet\LSA\DisallowMsvChapv
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• Make sure that the following key is set to a value of 1, 2, 3, or 4. A setting of 5 will cause
Ignition Server’s support for MSCHAPv2 authentication to fail in all cases. The key name
is:

HKLM\System\CurrentControlSet\Control\LSA\LMCompatibilityLevel
5. Find or create your service account. Make sure you have a user account in AD that can

act as the Ignition Server Service Account. If you need to create a new account, follow the
instructions in Creating the Service Account in AD on page 53.

6. Set permissions on your service account. If you wish to perform MSCHAPv2
authentication, make sure your Ignition Server Service Account has, at a minimum,
permission to create and delete computer accounts in the Netlogon account root of AD. If
you need set this up, follow the instructions in Setting the AD permissions of the service
account on page 55.

7. Optional: Check your machine authentication settings. If your organization’s security
policy requires a script to run on each client before that client may connect, then do the
following:

• Make sure all client machine names are saved in the correct location in AD, which is
typically under “cn=computers, ...”.

• Make sure this location is set in Ignition Server as the User Root DN or any container
above that in the directory tree.

8. Recommended: Make DNS settings on Ignition Server. If your site uses MSCHAPv2
authentication, Avaya strongly recommends that you configure your Ignition Server
appliance’s DNS settings so that Ignition Server can resolve the address of your AD server.

To check and edit your DNS settings, click Configuration in the Dashboard main window,
click the name of your node in the navigation tree, then click the System Tab, and click the
DNS tab. Click Edit. You can check and edit the addresses of your DNS servers in the Edit
DNS Configuration window.

Next steps
Connect to AD as explained in Connecting Ignition Server to AD on page 59.
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Creating the Service Account in AD
To connect to Active Directory, the Ignition Server appliance requires a user account (which we call
a service account) in Active Directory. If you wish to perform MSCHAPv2 authentication, then this
service account must have write and delete permissions in the Netlogon account root of your AD
service. The location of the service account in AD does not matter.

If you have a suitable account already, you may skip this section and go to Setting the AD
permissions of the service account on page 55. To create an account, follow the steps below.

Procedure
1. Log into your AD server machine as the Domain Administrator or as a user with sufficient

privileges to create users.

2. Open the Active Directory Users and Computers snap-in from the Administrative Tools or the
Windows Control Panel.

3. In the object tree on the left side, click on the container in which you will create the new user.
For this example we’ll use the Users container.

4. Select Action > New > User.

5. In the New Object - User window, create the Ignition Server service account. Avaya
recommends creating an account that will be used exclusively by the Ignition Server
appliance. For this example, we use the account name, “ideadmin”. Click Next after
specifying the name.
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6. Assign a secure password to the account. Follow your organization’s password policies. If
you wish to ensure the reliability of the service account, select the User cannot change
password and Password never expires check boxes.
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7. Click Finish to save the new account.

Setting the AD permissions of the service account
If you plan to support MSCHAPv2 authentication, the Ignition Server service account must have
permission to create and delete computer accounts (the Create Computer Object and Delete
Computer Object permissions) in the Netlogon account root of your Active Directory service. For a
description of this container, see Netlogin Account Root DN in Settings for connecting to an AD
Store on page 49.

This section shows you how to grant the minimal required permissions to your service account. If
your service account already has the right permissions, proceed to Gather Active Directory
connection settings on page 49 instead.

Procedure
1. Log into your AD server machine as the Domain Administrator.

2. Open the Active Directory Users and Computers snap-in from the Administrative Tools or the
Windows Control Panel. Under View, enable Advanced Features.

3. In the object tree on the left side, click on the container that will serve as your Netlogon
account root. You may configure the location Ignition Server will use as the Netlogon
account root. See Netlogin Account Root DN in Settings for connecting to an AD Store on
page 49 for information on setting or finding this DN.

If you want to create a new container that will serve as the Netlogon account root, click on
the root domain in the tree and create the new OU there.
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4. Right-click your Netlogon account root container, select the Security tab, and, under the
Permissions for Account Operators list, click Advanced.

5. In the Advanced Security Settings window, click the Permissions tab and:

• Make sure the Allow inheritable permissions from the parent to propagate... check
box is selected.

• Click Add.
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6. In the Enter the object name field, type the name or partial name of your Ignition Server
service account and click Check Names.

7. The window displays a list of names that match the name you typed. Click the desired
account name and click OK.
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8. In the Permission Entry window, click the Object tab and:

• In the Apply onto field, choose This object and all child objects.

• In the permissions table, scroll to find the rows, Create Computer Objects and Delete
Computer Objects, and select the Allow check box for each.
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• Click OK.

9. Click OK again to dismiss the Advanced Security Settings window and again to close the
snap-in.

Now that you have granted the Ignition Server service account the appropriate permissions,
the Ignition Server can authenticate users against the AD service.

Next steps
Gather Active Directory connection settings on page 49

Connecting Ignition Server to AD
To connect Ignition Server to your Active Directory data store, save the AD store as a directory
service in Ignition Server. The directory service specifies the connection settings that Ignition Server
uses to connect to AD. Create one directory service for each AD domain you wish to connect to.
You can search across multiple directory services by grouping them into a directory set as explained
in Creating a directory set on page 79.
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The sections that follow assume that your user data resides in Active Directory and that you have an
AD user account that you can use as the Ignition Server service account. If you need to create a
service account, go to Creating the Service Account in AD on page 53.

Connect using Ignition Server’s AD connection wizard in automatic connection mode.

Procedure
1. In Dashboard’s Configuration tree, click Site Configuration.

2. Click the Directory Service link in the main panel.

3. In the Choose Service Type window, click Active Directory and click Next.

4. In the Configuration Options window, click Automatically configure and click Next.

If your AD connection attempt fails while you are carrying out the following steps, see 
Troubleshooting AD and LDAP connections on page 69.

5. In the Connect to Active Directory window, enter the connection settings you gathered in 
Gather Active Directory connection settings on page 49, or use the login you created in 
Creating the Service Account in AD on page 53 and click Next.

6. In the next Connect to Active Directory window, do the following:

a. Enter the AD service account credentials in the Service Account Name and Password
fields.

b. Select the Security Protocol: choose Simple for unencrypted communication with AD,
or choose SSL for encrypted communication.
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c. In the IP Address field, type the address of your desired AD server.

d. Check the Port setting and edit it if needed. Ignition Server defaults to the port number
used by most AD servers.

e. Click Next.

7. In the Configure Active Directory window, do the following:

a. In the Settings section, type a Name for this directory service. For this example, enter
Sunnyvale-AD-1.

b. In the Joined Domain As section, the settings are already populated by the wizard. If
you need to change a setting, click the lock/unlock button and edit the field. For an
explanation of each field, see the table in Gather Active Directory connection
settings on page 49.

c. The Primary Server IP Address and Port fields are populated by the wizard; if
necessary, click to unlock and edit them.
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d. The Secondary Server IP Address and Port fields are optional. If you have a backup
AD server, enter its address here.

e. The DN Configuration fields are populated by the wizard; if necessary, edit them. The
Directory Root, User Root, and Netlogon Account Root are explained in Settings for
connecting to an AD Store on page 49. You can type the DN directly or click Browse to
browse your directory to find it. Note that the schema browser does not display auxiliary
classes; those you must type directly.

Selecting the Accept all users in the forest check box allows Ignition Server to look up
users in the global catalog of your AD.

f. The Ignition Server maintains an internal cache of the group hierarchies and attribute
schemas of the directory services. If necessary, in the Group Caching section, disable
this caching by clearing the Enable Group Caching check box.

g. By default, Ignition Server looks for groups starting at the Directory Root DN. You can
change this default behavior by specifying Group Search Base DNs. This is useful in
case of huge AD deployments, where starting at the root DN can take up a substantial
amount of time. In addition, you can restrict the types of groups that IDE caches by
specifying a custom Group Search Filter. The filter follows the LDAP query syntax.

h. Enter the sync interval between Ignition Server and Active Directory, in hours, in
Resync Duration.

The range is 1 to 168 hours. The cache is automatically refreshed based on this setting.
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8. Click Next.

The wizard applies your settings to create the directory service in Ignition Server and
displays the confirmation page.

9. If the settings are correct, click Finish to create the directory service.
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Next steps
Do one of the following:

• If the connection attempt succeeded, continue with Creating a directory set on page 79.
• If your connection attempt failed, see Troubleshooting AD and LDAP connections on

page 69.

Editing a directory service
Use this procedure to edit your directory service.

Procedure
1. In the Dashboard Configuration tree, expand Site Configuration > Directories >

Directory Services, and click the name of your directory service.

2. The main panel displays the connection details of the service. To test the connection, click
the Test Configuration button. To edit the connection, click Edit.

Connecting to LDAP
To connect Ignition Server to your LDAP store, you will save the store as a directory service in
Ignition Server. The directory service specifies the connection settings that Ignition Server uses to
connect to LDAP. You will create one directory service for each LDAP server you wish to connect to,
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and you can search across multiple directory services by grouping them into a directory set as
explained in Creating a directory set on page 79.

The sections that follow assume that your user data resides in LDAP and that you have an LDAP
administrator account that you can use as the Ignition Server service account.

You will connect using Ignition Server’s LDAP connection wizard in automatic connection mode.

Procedure
1. In Dashboard’s Configuration tree, click Site Configuration.

2. Click the Directory Service link in the main panel.

3. In the Choose Service Type window, click your type of LDAP store (for example, Generic
LDAP) and click Next.

4. In the Service Configuration Options window, click Automatically configure and click Next.

If your LDAP connection attempt fails while you are carrying out the steps below, see 
Troubleshooting AD and LDAP connections on page 69.

5. In the Connect to LDAP window (specific to the type of LDAP store that you selected), do the
following:

a. In the Service Account DN field, enter the DN of the LDAP administrator account.
Ignition Server will connect as this administrator. For example, cn=Directory Manager.

b. In the Service Account Password field, enter the password of the LDAP administrator.

c. Use SSL: If Use SSL is turned on, Ignition Server uses SSL to encrypt traffic to the
directory service. Warning: If you choose to connect to LDAP using a non-SSL
connection, your service account credentials will travel over the network in unencrypted
form. Avaya strongly recommends using an SSL connection to connect to your directory
server.

d. In the IP Address field, enter the IP address of the primary LDAP server.

e. In the Port field, enter the Port number at which the LDAP service can be reached.
When Use SSL is selected, the Port Entry is typically 636. When Use SSL is not
selected, the Port Entry is typically 389.
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6. Click Next.

The Configure LADP window appears.

7. In the Settings section, type a Name for this directory service. For this example,
Sunnyvale-LDAP-1.

The DN and Username fields are populated by the wizard; if necessary, edit them or click
the Browse button to set them. Note that the schema browser will not display auxiliary
classes; those you must type directly. The fields are:

• Directory Root DN: DN where the LDAP schema containing your users and groups may
be found. For example, dc=company,dc=com. When you connect the directory service,
the Ignition Server Create Service wizard will attempt to choose a Directory Root DN for
you.

• User Root DN: DN of the LDAP container Ignition Server from where will load user
records. For example, cn=users,dc=starironinc,dc=com. When you connect the directory
service, the Ignition Server Create Service wizard will attempt to choose a User Root DN
for you.

• Username Attribute: An LDAP attribute that stores the user name.

Optional: If you wish to have Ignition Server strip the realm name from the username
before submitting it for authentication, click the Strip Realm check box. If this box is
checked, then, for example, the user name jsmith@company.com would be submitted to
LDAP as jsmith.

Optional: If this LDAP store will support MSCHAPv2 authentication, check the
MSCHAPv2 authentication check box and, in the LDAP Password Attribute field, set

Configuration

66     Avaya Identity Engines Ignition Server Getting Started Configuration August 2015
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Identity Engines Ignition Server Getting Started Configuration


the name of LDAP attribute that stores the hash of the user’s MSCHAPv2 password. See
“Setting up MSCHAPv2 Authentication on LDAP” in Avaya Identity Engines Ignition Server
Administration, NN47280-600 for details.

8. The Primary Server IP Address and Port fields are populated by the wizard; if necessary,
click the padlock button to unlock and then click in the fields to edit them.

The Secondary Server IP Address and Port fields are optional. If you have a backup
server, enter its address here.

9. In the Group Caching section

a. The Ignition Server maintains an internal cache of the group hierarchies and attribute
schemas of the directory services. If necessary, disable this caching by clearing the
Enable Group Caching check box.

b. By default, Ignition Server looks for groups starting at the Directory Root DN. You can
change this default behavior by specifying Group Search Base DNs. This is useful in
case of huge deployments, where starting at the root DN can take up a substantial
amount of time. In addition, you can restrict the types of groups that IDE caches by
specifying a custom Group Search Filter. The filter follows the LDAP query syntax.

c. Enter the sync interval between Ignition Server and the LDAP service, in hours, in
Resync Duration.

The range is 1 to 168 hours. The cache is automatically refreshed based on this setting.

10. Click Next.
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The wizard applies your settings to create the directory service in Ignition Server and
displays the confirmation page.

11. Review the settings. If the settings are correct, click Finish to create the directory service.

Your directory service has been saved in Ignition Server.

Next steps
Do one of the following:

• If the connection attempt succeeded, continue with Creating a directory set on page 79.
• If your connection attempt failed, see Troubleshooting AD and LDAP connections on

page 69.

Editing a directory service
Use this procedure to edit your directory service.

Procedure
1. In the Dashboard Configuration tree, expand Site Configuration > Directories >

Directory Services, and click the name of your directory service.

2. The main panel displays the connection details of the service. To test the connection, click
the Test Configuration button. To edit the connection, click Edit.
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Troubleshooting AD and LDAP connections
This section contains tips to troubleshoot AD and LDAP connections.

Checking a directory connection
About this task
Follow this procedure to check that Ignition Server is connected to your directory service.

Procedure
1. In Dashboard’s Configuration tree, expand Site Configuration > Directories > Directory

Services, and click the name of your directory service.

2. Click Test Configuration.

Ignition Server tests the connection to the primary server and, if configured, the secondary
server. For each server, the connection test consists of an anonymous bind to the directory,
retrieval of the directory’s root DSE, a bind using the service account credentials, and a
search for the user root.

The Test Connection Results window displays the test outcome, displaying one success/
failure line for the primary server and one line for the secondary server, if configured.

Checking directory connections and cache status
About this task
Use the following procedure to check the connection status and cache status (Ignition Server
caches user group memberships) of all of your directory services.

Procedure
1. Click on Dashboard’s Monitor tab.

2. In the navigation tree, click the IP address of your node (your Ignition Server).

3. Click the Directory Services Status tab.
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4. Click the name of your directory service.

5. Click Recheck Service.

For each service, the Directory Services window displays a row indicating the connection
status to that service. A blue check mark indicates Ignition Server succeeded in connecting
to the server; a red x indicates it failed to connect.

The Group Cache column is applicable only to a Directory Service of type Active Directory.

The Realm Mapper Cache column is applicable only to a Directory Service of type System
manager.

The SSO Kerberos Ready column is relevant only for troubleshooting SSO configuration. It
is not applicable to NAC (Network Access Control) configuration.

Testing a directory in-depth
About this task
Use the following procedure to test a directory in-depth.

Procedure
1. In Dashboard’s Troubleshoot tab, in the navigation tree, click the IP address of your Ignition

Server.

2. Click the Directory Service Debugger tab.

3. Click the Process Request, User Lookup, Device Lookup, Auth User , or Process
Kerberos tab to run your tests. For instructions, see “Advanced Troubleshooting for
Directory Services and Sets” in the Avaya Identity Engines Ignition Server Administration
guide.

Looking up AD settings to find Root DNs
About this task
Use the following procedure to find your User Root DN and Directory Root DN.
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Procedure
1. Enter the names of containers in your AD data store using X.500 naming.

• User Root DN points to the AD container that stores your user records.

• Directory Root DN points to the root of your AD tree and is used to obtain schema and
group information.

2. To determine the X.500 names of your containers, open the Active Directory Users and
Computers snap-in and check the tree panel on the left.

At the root of the tree is the DNS name of your AD server. This provides the
“dc=company,dc=com” portion of the name in the following example. For User Root DN, you
must find the appropriate container (“CN”) or organizational unit (“OU”) and use its name as
the “cn=” or “ou=” portion of the name. Note that an OU name can contain spaces, but that
no space may directly follow a comma in the X.500 name.

Form the full User Root DN name by pre-pending the CN or OU portion of the name to the
root portion of the name as shown in the preceding two examples. In the text that follows, we
continue to use “cn=users,dc=company,dc=com” as our DN example.

Looking up AD settings to find Domain and NetBIOS names
About this task
Use the following procedure to find the AD Domain Name and NetBIOS Name.

Procedure
1. Open the Active Directory Users and Computers snap-in and find your root domain in the

tree panel on the left.

In this example, the root domain is “company.com”.
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2. Right-click the root domain name and select Properties to open the Properties window.

3. In the General tab of the Properties window, use the uppermost name as the “AD Domain
Name” in Ignition Server, and use the Domain name (pre-Windows 2000) as the “NetBIOS
Name” in Ignition Server.

Looking up AD settings to find AD server IP address
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About this task
Use the following procedure to find the IP address of your AD server.

Procedure
Log in to the machine that hosts your AD server and perform one of the following actions:

• Use the “ipconfig” tool from the command line.

• Open the Windows Control Panel and select Network Connections > Local Area Connection.

In the Local Area Connection Status window, click Properties.

In the Local Area Connection Properties window, click TCP/IP and then click Properties.

Read the IP address from the TCP/IP Properties window.

Setting up a RADIUS proxy server
A RADIUS proxy server forwards RADIUS requests to a remote server for authentication. The
Ignition Server can act as the RADIUS proxy server that forwards the authentication requests, or as
the remote server that receives the authentication requests.

The forwarding server performs local authorization after receiving a response from the remote
server to suit the local network deployment. After the forwarding server completes authentication,
the information is logged for both success and failure.

If you are using a RADIUS proxy server, you must configure an authentication service in Ignition
Server. In Ignition Server, you manage authentication services in the Directory Services panel, in
the same way you manage directory services.

Setting up a RADIUS proxy server
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Adding the RADIUS proxy server to a directory set
After you create a RADIUS proxy authentication service, create a directory set. See Creating a
directory set on page 79. You add the RADIUS proxy server to a directory set to specify that the
RADIUS proxy server is the authentication service that verifies user credentials. You can add
multiple remote servers to a directory set. Each remote server can handle different realms, or
multiple remote servers can support the same realm to handle a fail-over scenario. When you add a
RADIUS proxy server to a directory set, ensure that the User Lookup Service field is set to none.
Note that you cannot add another type of directory service to a Directory set that contains a proxy
service.

Creating a RADIUS Access Policy for RADIUS Proxy Server
The next step is to create an Access Policy that includes the RADIUS proxy server. When you
create your Identity routing policy, use the directory set that includes the RADIUS proxy server. In
the Realm-Directory Set Map window, configure the realm for which the user wants to proxy the
request. See Setting your identity routing policy on page 90.
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Creating a new RADIUS Proxy Policy
Use this procedure to create a new RADIUS Proxy Policy and add authorization policy rules.

Each rule consists of one or more constraints. Each constraint tests the value of an attribute. If there
are multiple constraints, you can join them into separate logical statements to ensure the proper
order of authorization as required.

The rule action determines whether the user is denied or granted access based on the defined
constraints.

Procedure
1. In Dashboard’s Configuration hierarchy tree, expand Access Policies and click PROXY.

Click New.

2. Enter the Access Policy Name and click OK.

3. Highlight the new access policy name, and click Edit.

The Edit Authorization Policy window displays.

4. Do one of the following:

• To add a new rule, click Add in the Rules panel, enter a Name for the new rule and click
OK.

• To copy an existing rule, click Copy in the Rules panel, select the desired rule, and click
OK.

5. To set up rule details, highlight the rule name in the Rules list.

The rule details are shown in the Selected Rule Details pane. Any existing constraints for
the selected rule are listed in the Constraints list.

6. Do one of the following:

• To add new constraints, click New.
• To edit existing constraints, highlight the constraint and click Edit.

7. From the Attribute Category drop-down list, select the category.

All of the valid attributes for the category are listed.

8. Select the desired attribute.

The configurable details for the selected attribute are displayed.

9. Configure the attribute details as applicable:

• Select the comparison operator.
• Select the format.
• To compare the attribute value with a fixed value, select the Static Value radio button and

type or choose the comparison value in the field below.
• To compare the attribute value with a value retrieved from another attribute, select the

Dynamic Value of Attribute radio button. In the drop-down list below, choose the
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Attribute Category. In the second drop-down list, choose the attribute that should provide
the comparison value. The list of comparison attributes contains only those attributes
whose data type matches the data type of the constraint attribute.

10. Click OK.

11. Repeat Steps 6 through 10 for each constraint.

12. To logically group multiple constraints, in the Constraint list, highlight the first and last
constraints to be grouped and use the opening and closing parentheses drop-down lists to
group the constraints. Use the AND/OR drop-down list to form a logical condition statement.

13. Do one of the following:

• Select Deny for the Action and go to Step 15.

• Select Allow for the Action.

14. If you chose Allow for the Action, do the following:

• In the Send Attributes row, click the Edit icon, and use the left and right arrows to add or
delete attribute values from the Attribute List.

The forwarding server updates (if present) or adds (if not present) these attributes to the
remote server response before sending to the authenticator.

• In the Delete Attributes row, click the Edit icon, and use the left and right arrows to add
or delete attribute values from the Attribute List.

The forwarding server deletes these attributes from the remote server response before
sending to the authenticator.

Note that, when a forwarding server receives a response from a remote server, the first
Delete Attribute is applied, and then the second, and so on. All of the attributes defined in the
Delete Attribute List on the forwarding server are deleted first. After that, the first Send
Attribute will either add the attribute or update an existing attribute value that may be present
in the remote server response. Then the second, and so on. After applying Delete, Send (in
that order), the forwarding server sends a response back.

15. Check the Summary section to confirm the rule details, and click OK.

The policy and associated rules is saved.

Creating a RADIUS proxy authentication service
Use this procedure to create a RADIUS proxy authentication service. The Create Service Wizard
guides you through the steps.

Procedure
1. In the Dashboard Configuration hierarchy tree, click your site, expand Site Configuration,

expand Directories, and click Directory Services. Click New.

2. Select the radio button for RADIUS Proxy Service and click Next.
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3. In the Configure RADIUS Proxy Service window, assign the authentication service a name in
the Name field. This is the name you will use in your Ignition Server policy to specify that this
RADIUS proxy server should be used.

4. Enter the Shared Secret for the RADIUS proxy server.

5. Select the Proxy Policy from the drop-down list.

This policy determines how to update the RADIUS response from the remote server and
change the authorization attributes to suit the local network deployment. This policy can only
be associated with the Radius Proxy type of directory services and include only
authorization.

The list contains the proxy policies configured on the system. By default, it is associated with
a default policy that has no local authorization.

For more information about configuring the proxy policies, see Creating a new RADIUS
Proxy Policy  on page 75.

6. To send a regular “keepalive” ping, check the Enable Keepalive checkbox. Optionally, you
can specify a Keepalive User Name and a Keepalive Password. These are the user name
and password of a test account in your authentication server.

The user credentials you enter to test keepalive do not have to be valid credentials. A reject
message from the remote server for looking up invalid credentials is sufficient to determine
reachability.

With Keepalive turned on, Ignition Server periodically looks up the supplied username/
password on the remote server to determine reachability, and if successful, marks the
service as Connected in the Directory Services Status tab. By default, Ignition Server uses
a predefined username and password (idengines/idengines) to run the keepalive. If you
entered a Keepalive User Name and a Keepalive Password, Ignition Server uses these
credentials to run the keepalive.

With Keepalive turned off, the Ignition Server assumes that the remote server is always
reachable and marks it as Connected. You can test the connection at any time using the
Test Keepalive button in this window, or using the Directory Service Debugger tab of the
Dashboard’s Troubleshoot view.

Note:

Avaya recommends that you enable keepalive if you have multiple remote servers that
receive requests. If one server is reported down, the requests can be proxied to the next
available proxy server as defined in the directory set. If you do not enable keepalive, the
Ignition Server assumes that the remote server is always connected and the requests
may get dropped if the remote server health status is not determined.

7. Specify the IP Address and Port for the primary RADIUS proxy server and optionally for the
secondary RADIUS proxy server.

If both the primary and secondary servers are configured and the Keepalive is not enabled,
RADIUS proxy authentication attempts will occur with the primary server only. To ensure that
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authentication with the secondary server occurs following a failed authentication attempt with
the primary server you must enable the Keepalive mechanism.

8. Click the Test Keepalive button.

Testing the connection may take a few minutes. If a configuration setting is incorrect, Ignition
Server warns you.

9. Click Next.

The next window summarizes the connection settings of the service.

10. Click Finish.

Your new service appears in the Directory Services list. A blue check mark in the Connected
column indicates a successful connection.

Configuring the remote RADIUS server
After you set up the RADIUS proxy server, you must perform some configuration tasks on the
remote RADIUS server.

Creating an Authenticator
For the remote RADIUS server, the proxy (forwarding) server acts as an authenticator. Create an
authenticator similar to creating a regular authenticator, that points to the proxy server. From the
Dashboard, go to Configuration > Site Configuration > Authenticators and click New.

Creating an Access Policy
Assign an Access Policy that is capable of handling authentication requests from the proxy server.
Create a regular Access Policy as you would for any regular authenticator and configure the
necessary authentication and authorization policies. Make sure that the shared secret configured
here matches the shared secret as configured at the forwarding server’s proxy service.

Proxying of MAC authentication requests
MAC authentication is typically used for devices that are incapable of performing 802.1X
authentication. MAC authentication requests are also RADIUS requests. MAC authentication verifies
that the MAC address submitted by a connecting client device matches an entry on your list of
known MAC addresses. Using RADIUS proxy service, Ignition Server can also proxy the MAC
authentication requests to a remote server. To proxy MAC authentication requests, enable RADIUS
authentication for the authenticator and assign the access policy that is configured to use a proxy
directory set. Do not enable MAC authentication for the authenticator which would otherwise do a
local MAC authentication. On the remote server, enable MAC auth for this authenticator (proxy
server) and configure the necessary MAC authentication policy.
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Creating a directory set
A directory set is the mechanism Ignition Server uses to scan multiple directories for a user account.
You will define each user data store (that is, each AD data store, LDAP data store, and the
embedded store) as a directory service in Ignition Server, and you will group those directory
services into a directory set. In order to authenticate a user, Ignition Server searches all the services
in the set. For the purposes of this exercise, one directory set and one directory service will suffice.

Procedure
1. In the Dashboard’s Configuration tree, click Site Configuration , and click Directory Set in

the main panel.

2. In the Directory Set window, type a Name for your directory set. The name should indicate
that this set determines the search order for user lookups at your site or organization.

3. Click Add to start adding directory services to the set.
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4. In the Directory Set Entry window, specify the directory that will provide user account data
and group memberships (User Lookup Service) and the directory that will authenticate
users (Authentication Service).

Usually these are one and the same directory. You may choose different directories in cases
where you wish to split your authentication from your user lookup, as you might when you
couple RSA SecurID authentication with authorization based on AD group membership.

For this example, we use the internal user store so that we can later demonstrate an
authentication of the user account we created earlier. If you have an LDAP or AD user you
can test with, you may use your AD or LDAP store instead.

• In the User Lookup Service drop-down list, select Internal User Store.
• In the Authentication Service drop-down list, select Internal User Store.
• Click OK.

5. If you are using an AD or LDAP user store, do the following:

• In the Directory Set window, click Add again.
• In the User Lookup Service drop-down list, select the directory service you created

earlier. In the example, we use the name Sunnyvale-AD-1.
• In the Authentication Service drop-down list, select your directory service again.
• Click OK.
• In the directory Set window, click the Fallthrough checkboxes in the top row of the table

to specify how you want Ignition Server to handle directory failover. By checking these
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boxes, you can, for example, specify that Ignition Server will attempt authentication
against ActiveDirectory1 if the user’s lookup in the Internal User Store fails.

6. Click OK to save the set.

Next steps
Map user groups as shown in Creating virtual groups on page 81.

Creating virtual groups
Virtual groups are Ignition Server’s mechanism for abstracting, or standardizing, group names
across multiple user databases. You can map an Ignition Server virtual group to many groups in
many databases, allowing you to treat these groups as a single group in your policies.

For example, you might create an Ignition Server virtual group called, “Administrators” and map it to
the DN, “ou=admin,ou=Users,dc=company,dc=com” in the user database of your Fresno office, and
also map it to the nsRole value “AdminGroup” in the user database in your Irvine office. Your access
policies would refer to the group by the single name, “Administrators”.

Virtual groups are required if you wish to evaluate group membership in your policies. Ignition
Server looks up group membership only by means of a virtual group, so even if you have only one
data store, you must create a virtual group.

This example shows a virtual group that maps to the Domain Users group in the AD store.

Procedure
1. In the Dashboard’s Configuration tree, expand Site Configuration > Directories > Virtual

Mapping, and click Virtual Groups.

2. In the Virtual Groups panel, click Actions > Add A New Virtual Group.
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3. Type the virtual group name and click OK. In this example, the virtual group name is
domain-users-vg. This group will contain the members of the “Domain Users” group of
the AD server.

4. In the Virtual Groups list, select the group name you just created. At the bottom of the Virtual
Group Details panel, click Add.

5. In the Map Groups window, click in the Directory Service drop down list and select the name
of your Directory Service.
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82     Avaya Identity Engines Ignition Server Getting Started Configuration August 2015
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Identity Engines Ignition Server Getting Started Configuration


6. Use the tree list to find the group (AD container) you wish to map. In this example, the Active
Directory group is “CN=Domain Users”. This will enable us to create an Ignition Server
authorization rule that grants access to any user who is a member of Domain Users.

If you are using the Embedded Store, you can create an embedded group and map your
virtual group to that instead.
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7. Click OK.

The new mapping appears in the Mapped Groups list.
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Now that you have created a virtual group, you can use membership in the group as a
criterion for authorization and provisioning.

Next steps
Create a record in Ignition Server for your switch or access point, as shown in Creating
authenticators on page 85.

Creating authenticators
The network devices (switches, wireless access points, and VPN concentrators) that you secure
with Ignition Server are called authenticators. Once you have created an authenticator, you apply
your authentication, authorization, and provisioning policies to it.

Create an authenticator for each switch and/or access point that will authenticate against Ignition
Server.

Procedure
1. Gather the IP addresses and other settings of each authenticator you will connect. Ignition

Server can handle a large number of authenticators; we provide space to capture the
settings of two authenticators here. You will use these connection details in Step 4.

Authenticator 1 Authenticator 2 Authenticator 3
Authenticator Name ______________ ______________ Choose a name to

identify the
authenticator. This
name will be used to
refer to the
authenticator within
Ignition Server.

IP Address ______________ ______________ IP address of
authenticator.

Subnet Mask ______________ ______________ Optional: If you wish to
create one record (a
“bundle”) to represent a
number of
authenticators, this
field holds the mask
describing the subnet
in which all
authenticators will be
treated as one
authenticator.

Container ______________ ______________ Optional: If you are
grouping your
authenticators using

Table continues…
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Authenticator 1 Authenticator 2 Authenticator 3
Ignition Server’s
“Container”
mechanism, select this
authenticator’s
container.

Authenticator Type ______________ ______________ One of the following:
wired switch, wireless
access point, or VPN
concentrator.

Vendor ______________ ______________ Manufacturer of the
switch or access point.

Device Template ______________ ______________ Ignition Server
template to be used to
specify formats
(attribute names and
types) for
communicating with
this authenticator.

RADIUS Shared Secret To connect, you must have the shared secret of each device. Do not
record the shared secret here. In your switch documentation, the shared
secret may also be referred to as a “specific key string” or an “encryption
string.”

Access Policy ______________ ______________ Name of the Ignition
Server RADIUS policy
that contains your
access rules for users
connecting through this
authenticator.

2. In Dashboard’s Configuration tree, click Site Configuration.

3. Click the Authenticator link in the main panel.

The Authenticator Details window displays.
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4. Do the following:

• Fill in the fields using the information you collected in Step 1.

• Make sure the Enable RADIUS Access checkbox is checked.

• For Access Policy, choose the name of the policy you created in Step 3 on page 45.

For an explanation of the rest of the fields, see Avaya Identity Engines Ignition Server
Administration, NN47280-600.

5. Click Save to save the settings.

Next steps
Set your credential verification rules as shown in Setting your authentication policy on page 88.

Editing authenticators
Follow this procedure to edit authenticators.

Procedure
1. In Dashboard’s Configuration tree, expand Authenticators.
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Each name listed under the Authenticators node in the tree (for example, default) is an
authenticator container. Authenticator containers are used to group authenticators so that
you can apply a common treatment to them in your access rules. Many sites do not use this
feature, and leaving all your authenticators in the default container is a common practice.

2. Click on the node that contains your authenticator. For example, click on the default node to
open the authenticator you created earlier.

Setting your authentication policy
You created an empty access policy in the section Creating a RADIUS access policy on page 45. In
this section and the ones that follow, you will use the Access Policy panel to add an authentication
policy and add the various rules that make up your access policy.

An access policy is a set of rules that govern user authentication, secure communications for
authentication, search order for user lookups (called “identity routing” in Ignition Server),
authorization, and provisioning. The access policy controls whether and how that user will be
permitted to use the network, as well as how the authentication transaction is to be done.

In your Ignition Server system you may define many access policies for the many different segments
of your organization, but you will assign only one RADIUS access policy to each authenticator. This
means that all users connecting through that authenticator are governed by that RADIUS access
policy. You may use a single RADIUS access policy for any number of authenticators.

First you must set up your tunnel protocol policy. This policy specifies how to encrypt
communications among the supplicant, authentication server (the Ignition Server appliance) and the

Configuration

88     Avaya Identity Engines Ignition Server Getting Started Configuration August 2015
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Identity Engines Ignition Server Getting Started Configuration


user store during an authentication attempt. The outer tunnel secures the connection between the
supplicant and the Ignition Server appliance, and the inner tunnel secures the connection from the
supplicant to the user store if an external user store (like AD) is used.

Procedure
1. In the Dashboard Configuration tree, expand Site Configuration > Access Policies >

RADIUS, and click the policy name.

2. Click the Authentication Policy tab and click the Edit button.

3. In the Edit Authentication Policy window, the Authentication Protocols section lets you
establish the set of outer tunnel types and inner authentication protocols that your access
policy supports. In the Authentication Protocols section, choose each authentication type
as follows. The top-level headings (PEAP, TTLS, and NONE) represent the outer tunnel
types. Click the +/- toggles to view the authentication types available for each tunnel type.
Then:

• In the PEAP section, click the EAP-MSCHAPv2 check box.

• In the NONE section, click the PAP check box.
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If you want to verify that an authentication protocol is compatible with your data store, see
the section, “Supported Authentication Types” in Avaya Identity Engines Ignition Server
Administration, NN47280-600.

You can sort the order in which Ignition Server will attempt to apply the authentication types
to an authentication request by clicking the name of the authentication type or tunnel type
and clicking the up/down arrows to sort the list.

If your users are stored in Active Directory and the embedded store, then your policy will
typically include at least the PEAP/EAPMSCHAPv2 and NONE/PAP authentication types.

4. Click Save.

Setting your identity routing policy
The next policy to be set in your access policy is the identity routing policy. This is Ignition Server’s
prescribed sequence for searching a set of user stores to find a user account when attempting
authentication. This example sets a catch-all policy that will use a single directory set for all users.
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Procedure
1. In the Access Policy panel, click the Identity Routing tab and click Edit.

2. In the Edit Identity Routing Policy window, click New.

3. In the Realm-Directory Set Map window:

a. In the Directory Set drop down menu, select the directory set you created in Step 3 on
page 79. If you are using the example names, this will be the set called Sunnyvale-
User-Lookup.
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b. Click the Match All Realms check box.

c. Click the Disable Authenticator Container Matching check box.

d. Click OK.

In a production system, you can add more realm-directory set mappings in order to look
up various groups of users in various directory sets. When you do this, if you have an
entry that is set to Match All Realms, use the down arrow control to move that entry to
the bottom of the list.

4. In the Edit Identity Routing Policy window, click Enable Default Directory Set and, in the
Directory Set drop down list, choose Sunnyvale-User-Lookup.

The Edit Identity Routing Policy window now looks like the one shown below. Your directory
set name may differ.
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5. Click OK to save your routing and close the window.

Setting your authorization policy
The next policy to be set in your access policy is the authorization policy. This policy is a set of rules
that govern which users are granted access to which networks. Ignition Server can be set to
evaluate user attributes, device attributes, and the context of the access request in order to decide
whether to authorize the user.

The authorization policy can also prescribe provisioning for users as explained in the “Provisioning”
chapter of the Avaya Identity Engines Ignition Server Administration, NN47280-600.

This guide provides separate examples, depending on where you store your user accounts:

• If your user accounts reside in the Ignition Server internal user store, see Creating an
authorization policy—Example for embedded store users on page 93.

• If your user accounts reside in an AD user store, see Creating an authorization policy—
Example for AD users on page 96.

Note that you may store users in the embedded store, AD store, and additional stores at the same
time, and handle them all in the same access policy (See Setting your identity routing policy on
page 90).

Creating an authorization policy—Example for embedded store
users

If your user accounts are stored in the Ignition Server internal user store, set up your authorization
policy as shown below.

This section shows you how to create an authentication-only policy. Ignition Server always performs
both authentication and authorization before it grants a user access, but in some installations, you
may decide that authentication alone—checking the user’s credentials—is sufficient to grant the
user access. This example creates such a rule.
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Procedure
1. In the Dashboard Configuration tree, expand Site Configuration > Access Policies >

RADIUS, click the policy name, and click the Authorization Policy tab.

2. The top half of the Authorization Policy tab contains your RADIUS authorization policy.
Click the top Edit button to edit it.

The Edit Authorization Policy window displays.

3. In the Rules section, click Add.

The system displays the New Rule dialog, where you name the new rule.

4. Type Example-Allow-Rule and click OK.

The New Rule dialog closes. In the Edit Authorization Policy screen, the rule you just created
appears in the Rules list that occupies the left side of the window.

The Rules list shows the rule sequence that forms your authorization policy. The right side of
the window allows you to edit the rule you have selected in the list.

5. In the Rules list, click the rule you just created.

The Selected Rule Details section displays the Constraints that form the rule. Right now
there are none.

6. With your rule selected, go to the buttons to the right of the Constraint list and click New.
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7. In the Constraint Details window, do the following. The steps below create a rule that always
evaluates to true. Such a rule is not practical in a production system, but it demonstrates rule
setting in this exercise. Bear in mind that, even if you have an always-allow rule like this, the
authenticating user must still authenticate successfully and pass all DENY rules before
triggering an ALLOW rule.

• In the Attribute Category drop-down list, select the attribute category, System. In
response, the list shows all the attributes for System.

• In the list, select the attribute True.

• Click OK to close the Constraint Details window and return to the Edit Authorization Policy
window.

8. In the Action section, select the Allow radio button.
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9. In the Provisioning section, make no changes.

10. Click OK to close the Edit Authorization Policy window and return to the Access Policy
window.

You have finished setting policies in your access policy.

Creating an authorization policy—Example for AD users
The steps below show you how to create a policy that authorizes access for any user who has a
user account on the AD domain (that is, if the user has an account in the Domain Users group).
Upon authentication, the user is provisioned based on their virtual group name. Note that the virtual
group may map to a single AD workgroup or multiple workgroups on one or more domain
controllers.

Use the following procedure to create a rule that checks AD domain membership.

Procedure
1. In the Dashboard Configuration tree, expand Site Configuration > Access Policies >

RADIUS, click the policy name, and click the Authorization Policy tab. Click Edit to edit the
policy.
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2. The top half of the Authorization Policy tab contains your RADIUS authorization policy.
Click the top Edit button to edit it.

The Edit Authorization Policy window displays.

3. In the Rules section, in the lower left part of the window, click Add.

The system displays the New Rule dialog, where you name the new rule.

4. Type CheckHasADAccount and click OK.

The New Rule dialog closes. In the Edit Authorization Policy screen, the rule you just created
appears in the Rules list that occupies the left side of the window.

The Rules list shows the rule sequence that forms your authorization policy. The Selected
Rule Details section allows you to edit the rule you have selected in the list.

5. With CheckHasADAccount selected in the Rules list, go to the buttons to the right of the
Constraint list and click New.

To learn how Ignition Server evaluates sets of rules and constraints, see Avaya Identity
Engines Ignition Server Administration, NN47280-600.

6. In the Constraint Details window, create your constraint as follows:

a. In the drop down menu at the top of Constraint Details window, select the Attribute
Category, User. The list just below this displays the names of attributes of type User.

b. In the list, select the attribute named group-member.

c. In the drop down menu of the Phrase section, select Contains Any and click the Static
Value radio button.

d. Click the Add button.

e. In the Add Value window, select the virtual group you created Step 3. If you are
following the example, it is domain-users-vg. Click OK to close the window.

f. Click OK to close the Constraint Details window and return to the Edit Authorization
Policy window.
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7. In the Action section of the Edit Authorization Policy window, click the Allow button. In the
Provisioning section, make no changes.

At runtime, this rule will check whether the user is a member of the AD group, “Domain
Users.” If the user is a member, the rule records an ALLOW action. During evaluation, if at
least one ALLOW is recorded and if Ignition Server finishes evaluating the rule sequence
without triggering a REJECT, the user is authorized.

Configuration

98     Avaya Identity Engines Ignition Server Getting Started Configuration August 2015
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Identity Engines Ignition Server Getting Started Configuration


8. Click OK to close the Edit Authorization Policy window and return to the Policy Management
window.

Testing your configuration

Checking user lookup and authentication
Use Dashboard’s Directory Service Debugger to perform a test login with a user account from your
directory service.

Procedure
1. Click Dashboard’s Troubleshoot tab.
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2. In the navigation tree, click the IP address of your Ignition Server.

3. Click the Directory Service Debugger tab.

4. Click the Process Request tab.

5. Choose the Directory Set, Sunnyvale-User-Lookup.

6. Set the Inner Tunnel Protocol (authentication type) to one of:

• EAP-MSCHAPv2 for AD-stored users, or

• PAP for users stores in the internal user store.

7. Type a test Username and Password.

8. Click Send Request. The test results and retrieved user attributes appear in the Results
panel.

Using NTRadPing as a test authenticator
For testing, you can use a test tool such as Novell’s NTRadPing to send authentication requests
directly from your computer to the Ignition Server.

Procedure
1. Download the free NTRadPing tool from Novell and install it on your computer.
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2. Define your NTRadPing installation in Dashboard as an Authenticator:

• In the Dashboard’s Configuration tree, click Site Configuration. Click the Authenticator
link in the main panel.

• In the Authenticator Details window, type a Name for your test authenticator. Enter the IP
Address of the computer on which you installed NTRadPing. In RADIUS Shared Secret
enter any string of characters to use as the shared secret. Make sure the Enable RADIUS
Access checkbox is ticked and choose your Access Policy in the drop down list. In this
example, we used the name Sunnyvale-RADIUS-policy. Click OK to save.

3. Run NTRadPing and perform these steps in the NTRadPing window:

• In the RADIUS Server field, type the Ignition Server IP address that hosts the Ignition
Server RADIUS service is running. You can find this IP address in Dashboard. Click your
server’s IP address in the navigation tree. If you are using only one Ethernet interface on
your Ignition Server, then this is your RADIUS server IP address. Otherwise, click the
Ports tab to see the other IP addresses of your Ignition Server. If you use multiple
interfaces and need to determine which of them hosts the RADIUS service, click the top
node in Dashboard’s navigation tree, click the Services tab, click the RADIUS tab. The
Bound Interface field shows which interface hosts the service.

• In the RADIUS port field, type the port number of the Ignition Server RADIUS service,
which defaults to 1812. To find out the port number, click the Services tab and click the
RADIUS tab, as shown above. The Authentication Port field shows the port.

• In the RADIUS Secret Key field, type the shared secret you specified earlier in
Dashboard.

• Type your test credentials in the User-Name and Password fields.

• Click Send. The field in the lower part of the NTRadPing window indicates success or
failure and shows the details of the transaction.

4. Check Dashboard’s Log Viewer for details on your test authentication attempt.

• For a quick list of successful and failed authentication attempts, use the RADIUS AAA
Summary. To do this: In Dashboard, click Monitor, click the name of your Ignition Server
site (“Sunnyvale-Campus” in this example), click RADIUS AAA Summary, and click either
Succeeded of Failed.
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• For a detailed look at an authentication attempt, use the Log Viewer. To do this: In
Dashboard, click Monitor, click the IP address of your Ignition Server, click the Log
Viewer tab, and click the Access tab. Search through the list of log entries to find the
message that describes your authentication request. For more details, click the record and
click the Access Record Details link near the bottom of the page.
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